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1 Tekla Structures 2019i release
notes

Welcome to Tekla Structures 2019i!

Check the links below for information on the many new features and
improvements in this version:

• Trimble Connect Visualizer - Create 3D renderings of your models
(page 6)

• Switch between manual and automatic applying in the property pane
(page 9)

• Updates to the property pane, UDAs, and to the Property pane editor
(page 11)

• Snapping improvements (page 15)

• Search in model (page 22)

• New part types: lofted plate and lofted slab (page 22)

• Weld clash check, pour management, and other modeling improvements
(page 29)

• View improvements (page 31)

• Improvements in rebar sets and Rebar shape manager (page 32)

• Improvements in drawings (page 37)

• Improvements in rebar drawing tools (page 46)

• Printing to multiple printers and other printing improvements (page 48)

• Improvements in Tekla Model Sharing (page 52)

• Changes in Tekla Structures installation (page 53)

• New structure of firm and project folders (page 53)

• Interoperability improvements (page 54)

• Export to 3D DGN v8 - New 3D DGN export (page 57)
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• Export to 3D DWG - New 3D DWG export (page 59)

• Updates in tools for concrete fabrication (page 61)

• Improvements in components (page 64)

• Changes in advanced options (page 73)

• Tekla Structures 2019i fix list

Compatibility

We suggest that you complete any unfinished models using your current
version of Tekla Structures.

This version is not backwards compatible. When you create or save a model in
Tekla Structures 2019i, you cannot open it in older versions due to database
differences.

Tekla Structures 2019i can only be installed on 64-bit Windows operating
systems.

See the Tekla Structures 2019i Hardware Recommendations for more
information.

Tekla Structures 2019i requires Tekla License Server 2017 or later. To check
which license server version to use with your current Tekla Structures version,
see Which license server version to use.

Administrator's release notes

Advanced users should read the Tekla Structures administrator's release notes
(page 74) for information on how to apply the additional customizations
available in this release.

Localization release notes

Environment-specific changes are explained in the Localization release notes
(page 106).

Tekla Open API release notes

The Tekla Open API release notes can be found in the Tekla Developer Center .

1.1 Trimble Connect Visualizer - Create 3D renderings of
your models
Starting from Tekla Structures 2019i, you can now access Trimble Connect
Visualizer directly from Tekla Structures. In Trimble Connect Visualizer, you can
take snapshots or create animations that demonstrate the design of your
models and the build options, and use the snapshots and animations to create
more appealing sales and project presentations.
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Create 3D renderings and set material type mappings

The Visualize commands are located on the View tab.

• Click Visualize selected to open a rendering of the selected model objects
in Trimble Connect Visualizer.

• Click Visualize all to open a rendering of the entire model in Trimble
Connect Visualizer.

• Click Visualizer material type settings to open the Visualizer settings
dialog box, where you can adjust how the materials in your model are
shown in Trimble Connect Visualizer.

The material type mappings can be saved either:

• to the \attributes folder under the model folder, so that all users of
the model can use the material type mappings.

• to the app data, so that the same material type mappings can be
applied to all of your models.

Adjust the model view in Trimble Connect Visualizer
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You can zoom, pan, and rotate the model to view different angles of the
model.

To Do this
Zoom in or out Do either of the following:

• Scroll forward or backward with the mouse
wheel.

• Press the W and S keys on the keyboard.
Pan the model Do either of the following:

• Hold down the left mouse button, and drag the
model as needed.

• Press the A and D keys on the keyboard.
Rotate the model 1. Place the mouse pointer over the point around

which you want to rotate the model.

2. Hold down the left mouse button.

3. Drag the model as needed.

Click  on the Trimble Connect Visualizer side pane to further adjust the
scene. You can change:

• The used skybox, or background, and its rotation

• The position of the sun

• The brightness of the scene

• The visibility and position of the ground plane

Take and view snapshots

All snapshots that you take in Trimble Connect Visualizer are saved in the C:
\Users\<username>\Pictures\TrimbleConnectVisualizer folder.

• To take a snapshot of the current view, click  in the Trimble Connect
Visualizer side pane.

• To open the C:\Users\<username>\Pictures
\TrimbleConnectVisualizer folder and see all snapshots that you have

taken, click .

Create animations

You can create animations that show the model from different angles, or
views.

To start creating animations, click  on the Trimble Connect Visualizer side
pane.
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Then, click + to add the views that you want to include in the animation.

You can also adjust the speed of the animation and the sun position, and
preview the animation.

1.2 Switch between manual and automatic applying in
the property pane
In Tekla Structures 2019i, when you modify properties in the property pane,
you can use the new Set default values automatically option to switch
between automatic and manual applying of properties for the next objects of
the same type.

Previously, Tekla Structures always automatically saved the modified
properties and applied them for the next objects of the same type. The Set
default values automatically option makes the property pane more
consistent with the dialog boxes, where you use the Apply button to set the
properties for next objects of the same type. Now you can follow the same
workflow both in the property pane and in the dialog boxes.

The Set default values automatically option is not dependent on the
selected object type. You can switch between manual and automatic applying
at any time.

Enable manual applying of properties
1. Select an object in the model.

2. Click the Property pane settings  button in the property pane to
open a drop-down menu.

3. Ensure that the Set default values automatically option is not selected. 

A Set as default button appears at the bottom of the property pane.

Note that if you have selected multiple objects in the model, the Set as
default button does not appear.

4. Change the property values as needed.

5. Select how to proceed. 
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• To modify only the selected object, click Modify.

• To modify the selected object and to use the current values for the
next objects of the same type, click the Set as default button and then
click Modify.

• To use the current values for the next objects of the same type, but not
to modify the selected object, click the Set as default button.

Depending on your actions, Tekla Structures either modifies the selected
object or creates the next object of the same type using the current values.

Enable automatic applying of properties
This is the default option.

1. Select an object in the model.

2. Click the Property pane settings  button in the property pane to
open a drop-down menu.

3. Ensure that the Set default values automatically option is selected. 

When the Set default values automatically option is selected, Tekla
Structures automatically uses the current values for the next objects of
the same type.

4. Change the property values as needed.

5. Click Modify.

Tekla Structures modifies the object and creates the next object of the same
type using the current values.

The PropertyPaneSettings.xml file
When you modify the property pane settings, the current settings are saved to
the PropertyPaneSettings.xml file in the ..\Users\<user>\AppData
\Local\Trimble\Tekla Structures\<version>\UI\PropertyPane\
folder. If you do not change the settings, the PropertyPaneSettings.xml
file is not created.

The settings in the PropertyPaneSettings.xml file are:

• FilterMode: ByData for Show properties that have a value in the
property pane settings

• FilterMode: ByGroup for Show properties based on visibility settings
in the property pane settings

• AutoApply: True when Set default values automatically in the property
pane settings is selected
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• AutoApply: False when Set default values automatically in the
property pane settings is not selected

The PropertyPaneSettings.xml file is read when Tekla Structures is started
and a model is opened.

If the settings in the PropertyPaneSettings.xml file are customized, the
company administrators can distribute the customized property pane settings
to other users in the company. The PropertyPaneSettings.xml file needs
to be placed in the \PropertyPane\ subfolder in a model, project
(XS_PROJECT), firm (XS_FIRM) or environment (XS_SYSTEM) folder. The
property pane settings in the ..\Users\<user>\AppData\Local\Trimble
\Tekla Structures\<version>\UI\PropertyPane\ folder has the
highest priority, and after that Tekla Structures uses the default search order.

If the PropertyPaneSettings.xml file is placed in several different folder
locations, Tekla Structures reads the settings from different folders and
merges them.

1.3 Updates to the property pane, UDAs, and to the
Property pane editor
Tekla Structures 2019i introduces improvements in the property pane and the
Property pane editor. With these updates, especially the viewing and
modifying of user-defined attributes (UDAs) is now easier and more
straightforward.

New options to control the visibility of properties and user-
defined attributes in the property pane
You can now control which properties are shown in the property pane without
customizing the property pane layout.

Click the Visibility button to open a drop-down menu in the property pane.
When you open the property pane for the first time without any
customizations in firm, project, or environment folders, the Show properties
based on visibility settings option is selected by default.
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Expand all or Collapse all

Use to expand or collapse all the property groups.

Show properties that have a value

Select to show only those properties that have a value. This is useful especially
with user-defined attributes (UDAs). UDAs that have a value are always shown,
even if they have not been added to the property pane layout. This means that
you can view and modify the UDA values in the property pane without
customizing the property pane layout.

1. Select objects in the model.

Property pane shows all the properties and UDAs for which you or
someone else has entered a value. Properties and UDAs which do not
have a value are hidden.

UDAs that are not included in your current property pane layout but
which have a value are listed in the Additional matches property group.

2. Modify the property values as needed.

3. If you want to enter a value to an empty property, use the search to
temporarily show the needed properties, or select the Show properties
based on visibility settings option.

The Show properties that have a value option is common for all object
types. For example, if you select a steel beam in the model and use the Show
properties that have a value option, and then select a concrete beam in the
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model, only those properties that have a value are shown for the concrete
beam as well.

Show properties based on visibility settings

Select which property groups are visible and which are hidden. You can show
and hide property groups by clicking the property group names. The eye
symbols indicate which property groups are visible and which are hidden. You
can show and hide only the main level property groups, not nested groups.

1. Select objects in the model.

Property pane shows all the property groups which are visible in the
property pane.

Property groups with the  icon are visible. Property groups with the 
icon are hidden.

2. Modify the property values as needed.

3. If you want to make a hidden property group visible, click the eye icon
again.

The Show properties based on visibility settings option is common for all
object types. If different object types have property groups of the same name,
the visibility of a property group is adjusted for all the object types. For
example, if you select a steel beam and hide the Position property group, and
then select a concrete beam, the Position property group is hidden for the
concrete beam as well.

To easily define the default visibility of property groups, use the Property
pane editor. Note that the changes in the visibility settings in the property
pane override the default settings defined in the Property pane editor.

Customize...

Use to open the Property pane editor and customize the property pane
layout

Updates in the Property pane editor

Set property groups hidden or visible

You can define whether the property groups in the property pane are visible or
hidden by default.

For example, if you are an administrator, you can create property groups for
different user-defined attributes (UDAs) in the Property pane editor, and
then set the default visibility for each of the property groups.

1. In the property pane layout on the right, select the property groups you
want to hide.
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2. Right-click and select Hide by default.

The eye symbol changes to hidden: . The selected property groups are
now by default hidden in the property pane.

3. To have the property groups again by default visible in the property pane,
right-click and select Show by default.

The eye symbol changes to visible: . The selected property groups are
now by default visible in the property pane.

Note that visibility changes in the property pane override the default settings
defined in the Property pane editor.

Copy multiple property groups

In the Property pane editor, you can now select multiple property groups to
be copied.

1. In the property pane layout on the right, select the property groups to be
copied.

2. Right-click and select Copy properties, or click .

The copied property groups and the nested groups inside the property
groups are shown in the middle column. The copied property groups are
expanded and the content of the groups is shown.

3. Add the copied properties to a property pane layout by dragging the
Copied properties box from the middle column to the property pane
layout on the right.

All the copied property groups are added to the property pane layout as
they are. Previously, the copied properties were nested inside a Copied
properties container.

Additionally, when you add copied properties to the property pane layout and
the property group would be empty as a result of duplicate or incompatible
properties, the group is not created at all. Previously, an empty Copied
properties container was created without any properties.
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Improved search in the property pane
Search in the property pane has been improved. Now the search finds all the
properties and user-define attributes (UDAs) that are available for the object
type.

If you have several object types selected in the model, the search finds
properties that are common to all the selected object types. UDAs that match
to the search criteria are shown even if they have not been added to the
property pane layout. This means that you can view and modify the UDA
values in the property pane without customizing the property pane layout.

Properties and UDAs that are not included in your current property pane
layout are listed in the Additional matches property group.

Note that the search results may vary depending on the environment you are
using. Different environments can have different sets of properties available.

Additionally, if you enter a single asterisk * in the search box, all properties
and UDAs available for the selected object type are shown. You can then easily
enter a value for a property or for an UDA, even if the property or the UDA is
not visible in the property pane by default.

Improvements in copying of properties
You can now press Enter to finish the copying of properties instead of clicking
the Modify button.

1.4 Snapping improvements
Tekla Structures 2019i introduces new colors and other visual cues for
snapping. Also, the behavior of the orthogonal snapping has been slightly
changed.

Orthogonal snapping has lower priority among the snap
points than previously
The behavior of the Ortho tool has been changed. Now the orthogonal snap
points have the lowest priority among the snap points. If Tekla Structures
detects any other possible snap point than an orthogonal point, Tekla
Structures uses the found snap point instead of the orthogonal snap point. If
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there are no other possible snap points found, then Tekla Structures uses the
orthogonal snap point.

Snap tooltips for snap points
Now when you start a command that requires picking points and you move
the mouse pointer over objects in the model, Tekla Structures displays a snap
tooltip that shows the name of the snap point.

For example:

To show or hide these snap tooltips, click File --> Settings and select the Snap
tooltips check box.
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Snapping color changes
The colors related to snapping have been enhanced to make the snapping
easier and more accurate. The different visual cues in the model help you to
pick correct positions when you create model objects.

• When the Ortho tool is active and you start a command that requires
snapping to two or more points, for example a beam or polybeam, Tekla
Structures displays a rubber band line between the last point picked and
the snap point. The color of the cursor, line, and the angle symbol follows
the color of the work plane axis: red for x-axis, green for y-axis and blue for
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z-axis. For any other direction the line between the last point picked and
the snap point and the cursor is gray.

• If you are using the DirectX rendering:

when you start a command that requires snapping to several points, for
example a polybeam or a slab, Tekla Structures now displays the lines
between picked points as light gray and dimension lines as black.
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If you are using the OpelGL rendering:

the lines between picked points are white and the dimension lines are
black.

• If you are using the DirectX rendering:

the rubber band line between the last point picked and the snap point now
has a new line type and color which is clearly visible regardless of the
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background color of the model. The color of the rubber band line and the
color of the reference point symbol, which is the last picked point, is now
light gray.

If you are using the OpenGL rendering:

the color of the rubber band line and the color of the reference point
symbol, which is the last picked point, is now white.
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• Tekla Structures now displays a turquoise reference line or geometry line of
the object showing the line or the edge to which the snap point belongs to.
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Setting the temporary reference point by using a right-click
command
In Tekla Structures 2019, the handling of temporary reference point
information was changed. Starting from Tekla Structures 2019, the reference
point information is cleared when you interrupt a command. If you wanted to
use the reference points in Tekla Structures 2019, you had to set the reference
point manually by pressing the Ctrl key and picking a point when you run a
command.

Now in Tekla Structures 2019i, you can set the temporary reference point also
by right-clicking when a command is running and selecting the Define
temporary snap reference point option. If you use the Define temporary
snap reference point command, you need to activate it for every reference
point you pick.

1.5 Search in model
Now you can quickly search for objects in the entire model or within the
selected model objects by using the Model search toolbar.

When you run a search in the model, Tekla Structures searches for objects
whose property values contain the search term, and then highlights and
selects the objects that have matching property values.

For more information, see Search for model objects.

1.6 New part types: lofted plate and lofted slab
Tekla Structures 2019i introduces new part types: steel lofted plate and
concrete lofted slab. Use lofted plates to model rolled plates and plates with
double-curved form, for example. Use lofted slabs to model curved and
double-curved slabs or walls, for example.

Prerequisites and examples of lofted plates and lofted slabs
Before you can create lofted plates or lofted slabs, you need to have
construction objects in your model. Tekla Structures creates the shape of the
lofted part according to the geometry of the used construction objects.

You can connect the following construction objects as a lofted plate or a lofted
slab:
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• construction line to construction line

For example:

• construction line to construction arc

For example:

• construction arc to construction arc

For example:
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• construction circle to construction circle

For example:

Create a lofted plate or a lofted slab
1. Create the needed construction objects in the model. The shape of the

lofted part is based on the construction object shape. 

You need to have

• construction lines

• construction arcs

OR

• construction circles

2. Depending on whether you are creating a lofted plate or a lofted slab: 

• On the Steel tab, click Plate --> Create lofted plate .
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• On the Concrete tab, click Slab Create lofted slab 

3. On the toolbar that appears , click a button to specify whether to
create the part by using two construction objects, or by using a
construction object and a point. 

• If you selected Using two construction objects :

a. Select the first construction object: line, arc, or circle.

For example, if you are using two construction circles to create a
lofted plate:

Tekla Structures 2019i release notes 25 New part types: lofted plate and lofted slab



b. Select the second construction object:

Tekla Structures creates the lofted plate between the selected
construction objects.

• If you selected Using one construction object and a point :

a. Select the first construction object: line, arc or circle.

For example:
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Tekla Structures shows a preview of the part geometry. Use the
preview to set the direction and the height of the lofted part.

b. Pick a point.

Tekla Structures creates the lofted slab based on the preview.
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4. If you want to modify the shape of the lofted part, use the direct
modification dimension handles and dimension values. 

For example:
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Correct the geometry of a lofted plate or split a lofted plate
• In some cases when you try to create a lofted plate or a lofted slab by using

construction lines, arcs, or circles, the geometry of the part would become
self-intersecting. In these situations the part is not created, and Tekla
Structures displays the following status bar message: The resulting
surface would be self intersecting.

With construction lines or arcs you can try to resolve the situation by
changing the modeling direction of the construction lines or arcs. Select the

construction line or arc, and on the contextual toolbar click  Swap ends.

With construction circles you can try to resolve the situation by moving
either of the circles.

• If needed, you can split lofted parts. You cannot split closed cylindrical or
conical lofted parts.

Use the Split command on the Edit tab.

Limitations
• You can create unfolded single-part drawings of non-closed cylindrical and

conical lofted plates, meaning that the lofted plate was created by using
construction arcs but not construction circles. Other types of lofted plates
cannot be unfolded.

• Rebar sets do not work with lofted parts.

New template attribute IS_LOFTED_PART
Use the IS_LOFTED_PART template attribute in filtering, fox example, to check
whether the part is a lofted part. The attribute returns 1 if the object is a lofted
part, otherwise it returns 0.

1.7 Weld clash check, pour management, and other
modeling improvements
Tekla Structures 2019i contains the following new features and improvements
in modeling:
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Detect clashes between welds and other objects
When you run a clash check using Tekla Structures 2019i, you can check the
model for duplicate and overlapping welds and for clashes that occur between
welds and other objects such as parts and bolts.

To do this:

1. Click File menu --> Settings --> Options to open the Options dialog box.

2. Go to the Clash check settings.

3. In the Exact solid weld clash check list, select Yes.

4. Modify the other clash check settings if needed.

5. Run the clash check.

Tekla Structures checks the welds against other welds, against bolts, and
against the real geometry of the part profiles including roundings, and using
the weld solid dimensions with normal accuracy.

When you review the clash check results, note that you can now show a new
column, Object Type, in the Clash Check Manager dialog box.

Numbering improvements
Now if a part has a single-part drawing and you modify the part so that it
becomes identical to another part, the following things happen when you
number the model:

• Both parts receive the number of the unmodified part.

• The drawing is automatically cloned using the original drawing of the
modified part as a cloning template. The original drawing is saved with the
Quantity decreased comment in the Changes column in Document
manager.

Note that the cloning happens only if the Automatic cloning option is
selected in the Numbering Setup dialog box.

Performance improvements in pour management
Pour resolving speed has been improved. When opening a model that
contains pours, the initial pour resolving is now faster than before. This is
especially noticeable when opening models containing a large number of
pours.
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New ways to create item shapes and edit model geometry
In addition to importing item shapes or downloading them from Tekla
Warehouse, you can now create shapes using existing geometry and parts in
Tekla Structures models. For example, you can create a shape using a single
part or several parts that have been attached to each other.

To create a shape, do one of the following:

• Select a part, right-click, and then select Create shape from geometry.

• Go to Quick Launch, search for and select the Create shape from
geometry command, and then select a part.

Tekla Structures adds a new shape to the shape catalog using the part name
as the shape name.

You can then use the shape when you create items in the model. You can also
modify items and shapes further in the Geometry editing mode by dragging
vertexes, edges, and faces. This gives you an alternative way to model complex
structures such as slabs that slope to drains, for example.

1.8 View improvements
Starting from Tekla Structures 2019i, you can now show model views,
assemblies, and components in different view angles.

Show model views in a selected view angle
Model views now have a View angle option on the contextual toolbar.

You can examine the current model view in different view angles by selecting a
top, back, right, bottom, front, or left view.

To return to the original 3D view, click the button in the middle of the view
angle options.
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Show assemblies and components in a selected view angle
Assemblies and components, including connections and custom parts, now
have a View angle option on the contextual toolbar.

You can show the selected assembly or component in different view angles by
selecting a top, back, right, bottom, front, or left view.

The view angles are based on the assembly main part's coordinate system.
Because of that, the objects may not always appear as expected when you
select a view angle. Note that the full object is not always shown.

To return to the original 3D view, click the button in the middle of the view
angle options.

1.9 Improvements in rebar sets and Rebar shape
manager
Tekla Structures 2019i comes with many new features and improvements
related to rebar sets. Rebar shape manager has also been improved.
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Create cranking using end detail modifiers
In addition to the existing bar end options, such as hooks, you can now create
cranks using rebar set end detail modifiers.

In the Rebar end detail modifier properties, there is a new setting End type
where you can select Hook, Cranking, or an empty option if you do not want
to create hooks or cranks.

The new Cranking option is useful when you reinforce and splice walls or
columns of different size in successive floors, for example. In the Cranking
section, you can then define the crank properties.
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Group rebar set bars manually using property modifiers
You can now manually group rebar set bars using property modifiers. By
grouping bars you can combine their bar marks in drawings and keep bar lists
simple and organized. Manual grouping is useful if you want to group bars
regardless of their geometry or arrangement, or when you want fine-tune the
automatic grouping.

To manually group rebar set bars:

1. Create a rebar set.

2. Create a property modifier for the bars that you want to group.

3. Set the property modifier properties.

In the Grouping list in the General section, select Manual.

Other modifier improvements
• End detail modifiers have a new setting (user-defined attribute) Align bar

ends that you can use for aligning bar ends that are nearest to the
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modifier. This is useful when the lengths of straight bars are rounded
and/or step tapered.

By default, the end detail modifiers do not align bar ends, and the rounding
and step tapering happens at the tapered edge of the rebar set, and if both
edges are tapered, at the edge that has a larger angle.

• In the Rebar splitter properties, the user interface of the Cranked length
setting has been improved, and the options now have images:

Face-specific concrete covers for rebar sets
You can now use surfaces for defining face-specific concrete cover thicknesses
for rebar sets. This is useful, for example, when you want the concrete cover of
the rebar sets to be thicker at a specific part face or pour object face than at
other faces, or when you want the cover thickness to vary from face to face.

To do this:

1. Add a surface to the object face at which you want to change the concrete
cover.

2. Double-click the surface to modify its properties in the property pane.

3. In the Rebar set section, enter the concrete cover thickness in the
Concrete cover box.

4. Click Modify to apply the changes.

Tekla Structures will use this concrete cover thickness for rebar set bars at this
specific face.

Show or hide rebar set guidelines and modifiers
• You can now show or hide rebar set guidelines in model views. To do this,

click Concrete --> Rebar display options --> Guideline visibility . The
guidelines are by default shown when you select rebar set bars.

To switch between showing and hiding the guidelines, you can also use the
new advanced option XS_REBARSET_SHOW_GUIDELINES or keyboard
shortcut Alt+2.

• If you want to show the rebar set modifiers that have been created by
using components, set the advanced option XS_REBARSET_SHOW_
MODIFIERS_CREATED_BY_COMPONENTS to TRUE. By default, this advanced
option is set to FALSE and these modifiers are hidden.
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• The rebar set display options on the Concrete tab on the ribbon now have
the following order and new keyboard shortcuts by default:

• Leg face visibility: Alt+1

• Guideline visibility: Alt+2

• Property modifier visibility: Alt+3

• Splitter visibility: Alt+4

• End detail modifier visibility: Alt+5

• Rebar dimension visibility: Alt+6

• Color rebar groups: Alt+7

Keyboard shortcuts for reinforcement selection switches

The reinforcement selection switches  now have the following
keyboard shortcuts by default:

• Select rebar sets: Alt+Q

• Select rebar groups: Alt+W

• Select single rebars: Alt+E

Improvements in leg faces
• You can now use the Leg face visibility option (Concrete tab > Rebar

display options) also with rebar set bar groups and bars. Previously, the
option only applied to entire rebar sets and you had to have the Select
rebar sets selection switch active. Now you can have any reinforcement
selection switch active: either for rebar sets, bar groups, or single bars.

• Use the new advanced option XS_REBAR_MINIMUM_LEG_DEVIATION to
define whether rounding settings are applied to certain reinforcing bar legs
or not.

• Use the new advanced options XS_REBARSET_CREATION_ANGLE_
TOLERANCE_FOR_CROSSING_REBARS and XS_REBARSET_CREATION_
ANGLE_TOLERANCE_FOR_LONGITUDINAL_REBARS to control at which part
faces rebar set leg faces are created.

New .inp file for rebar set user-defined attributes
Tekla Structures 2019i introduces a new input file, objects_rebar_set.inp,
that contains the user-defined attribute definitions for rebar sets. The rebar
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set related user-defined attributes are now easier to maintain in one file than
in the several separate .inp files previously.

The objects_rebar_set.inp file is by default located in the ..
\ProgramData\Trimble\Tekla Structures\<version>\environments
\common\system folder.

Improvements in Rebar shape manager
• Rebar shape manager has been changed so that multiple sequential bar

bendings that form an arc are combined into one or more bendings (90
degrees or less) with the arc radius. This makes it possible to define
bending shapes containing a large radius bending no matter how many
individual bendings appear in the original bar geometry.

This functionality is in use when the new XS_REBAR_COMBINE_BENDINGS_
IN_EVALUATOR advanced option is set to TRUE (which is the default value).

If you set the advanced option to FALSE, the bendings appear as multiple
bendings and the shape is recognized as before.

• In Rebar shape manager, a new tolerance value, Curve tolerance, has
been added to the Tolerances tab. When XS_REBAR_COMBINE_BENDINGS_
IN_EVALUATOR is set to TRUE, the Curve tolerance value is used for
recognizing the arc in a bar that has multiple sequential bendings.

If the deviation of a bar leg from the arc is less than the tolerance, multiple
bendings are combined to one bending (or two bendings) with the arc
radius as the bending radius.

If the deviation is more than the tolerance, if Curve tolerance is set to 0, or
if XS_REBAR_COMBINE_BENDINGS_IN_EVALUATOR is set to FALSE,
bendings are not combined, but they appear as multiple bendings.

• Rebar shape manager has been changed so that when you right-click a
Bending schedule fields cell, if the list that opens contains a lot of items,
new sub-lists are now shown to keep the list sizes more compact.

1.10 Improvements in drawings
Tekla Structures 2019i contains several drawing enhancements in section
views, view frames, reinforcement group marks, dimensioning and Document
manager.
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Improvements in drawing views

New settings for section views

In single part, assembly and cast unit drawings on the Attributes tab of the
Section view properties, there is a new Size check box for the new Fit by
parts setting and the existing settings Section depth and Distance for
combining cuts. Now you can set Fit by parts for all section views in drawing
properties before creating a drawing. Earlier, you had to open each drawing
and manually readjust view depth for each section view in the opened
drawing .

The Fit by parts setting works as an alternative to Section depth and
Distance for combining cuts, and it shows the whole part in the sections. If
you select this setting in Section view or End view properties in an existing
drawing, it overrules the drawing level setting.

For more information, see Section view properties.

Drawing view frames now hidden

The drawing view frames are now hidden until you move the cursor over the
view. If you select a view, the drawing view frame stays visible.

Drawing view frames are overlapping and shown:
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Drawing view frames are overlapping and hidden, new functionality:
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Improvements in reinforcement drawing properties
• A new representation option outline (ignore holes) has been added for

meshes on the Mesh content tab in Reinforcement drawing properties
properties. This option ignores holes and draws over them.

Additionally, the missing representation option single line with filled ends
was added on the Mesh content tab for reinforcement meshes.

Below is an example of the new outline (ignore holes) option.
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As a comparison, below is an example of the outline option.

Improvements in reinforcement group marks
The drawing reinforcement group marks functionality has been improved. The
number of available leader line options for reinforcement group marks has
been increased: now it is possible to create marks with perpendicular leader
lines to reinforcement group plane, to all rebars in a group, and to the first and
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last rebar in a group. The new options are available in cast unit and general
arrangement drawings.

The new options are Perpendicular leader lines and Leader line to first and
last. Both new options allow you to create marks with perpendicular leader
lines to rebar group plane: Perpendicular leader lines creates marks with
leader lines to each rebar in a group and Leader line to first and last to first
and last rebar in a group.

Perpendicular leader lines:

Leader line to first and last:

You can control the length of the perpendicular leader line with the new
advanced option XS_MARK_LEADER_LINE_LENGTH_FOR_PERPENDICULAR
( File --> Settings --> Advanced options --> Marking: General ). The default
value is 0 mm.

Note that rebar mark leader lines created with the new options are always
placed horizontally or vertically in a drawing, even in tapered rebar groups.
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Earlier:

Now:

You can select to apply the new leader line options in the following locations:

• Before you create a cast unit drawing, in the cast unit drawing properties
for each view separately: Select the view in cast unit drawing properties,
click View Properties, and click Reinforcement mark or Neighbor
reinforcement mark from the options tree.

• Before you create a GA drawing, in the drawing properties of the GA
drawing: Click Reinforcement marks... or Neighbor reinforcement
marks... in the GA drawing properties.

• In the view properties of an existing drawing: Double-click the view frame,
and click Reinforcement mark or Neighbor reinforcement mark in the
options tree.

• In reinforcement mark properties in an open drawing: Go to Drawing -->
Properties --> Reinforcement mark .

• In reinforcement mark properties for an individual reinforcement group
mark: In an open drawing, double-click an individual reinforcement group
mark. To select and modify the properties for several reinforcement group
marks, use Drawing content manager or select the reinforcement group
marks using appropriate selection filters.
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Improvements in dimensioning
• View-specific dimensioning: The dimensioning type Shape dimensions

has new options for controlling which faces will be dimensioned. By
selecting the Visible faces option, dimensions will be created only to faces
that are visible in the drawing view. The other option All faces dimensions
all faces, similarly as shape dimensioning was doing previously. All faces is
the default value, and it will be used if the dimension settings file does not
contain any value for the new setting.

• It is now possible to associate dimensions to object center lines outside the
object area.

• Dimensioning plug-ins DLLs can now be found in sub-folders of <Tekla
Structures binary folder>\plugins\Tekla\Drawings
\Dimensioning\ and in environment in the sub-folders of \common
\extensions\custom\dimensioning\. Previously all the DLLs were
expected to be at the same level in those folders. This enables a better
separation of each plug-in dependencies.

Improvements in dimension tags

Tags allow you to display the properties and other related information of the
associated building objects in dimensions and dimension sets. This feature has
now been improved in several ways to make it work more consistently and
reliably.

Display any object type in dimension tag marks

In the Dimension Properties dialog box on the Tags tab, you can define the
contents of the dimension tags of building object dimensions. The logic for
displaying the contents has changed, and now all the building object
categories are checked for content availability. The properties in the first found
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category that has content are read and displayed in the tag. If you do not want
to display tag contents for some building objects, you can create an
appropriate exclusion filter for this building object type. This means that you
can now display properties related to any associated object regardless of its
type and order in the hierarchy.

The reading order of building object content categories is the same as in
earlier versions:

1. Surface treatment

2. Bolt

3. Rebar

4. Part/Pour object

Earlier, when a dimension was associated to several different building object
types, the properties of one category only were read and displayed in the tags.
The category from which the properties were read based on a hidden reading
order. The main problem was that if several object types were selected for
creating dimensions, only the properties of object type that was higher in the
reading order hierarchy were displayed in the tag. For example, if all the other
categories were empty, and the Part category had content, nothing was
displayed in the tag, because the Surface treatment category had no content.

Dimension tag contents now updated correctly

• Dimension tag contents are now updated correctly when you drag
dimension points.

• Dimension tag contents are now updated instantly when you add or
remove dimension points. Previously, the contents were not updated when
the dimension became associative to another building object.

Improvements in Document manager

For more information about Document manager, see Document manager.

New indicator for cells that cannot be edited

• When the edit switch  is active in Document manager, and you move
the mouse cursor over a cell that cannot be edited, the cursor now changes
to indicate that you cannot edit the cell:
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New category association options

The Edit category and New category dialog boxes in Document manager
now have a new setting Association type, which defines if a category is search
based, manual, or both.

• If the category is of type Search only or Manual and search, you need to
define a Search string in the dialog box.

• If you create a category by first selecting documents from the documents
list, the association type is Manual only by default.

• If you create a category from the category list, the association type is
Search only by default.

• You can change the association type later. If you change the type from
Search only to Manual only, a message is displayed telling that the search
string for that particular category will be cleared. If you change the type
from Manual only to Search only or Manual and search, you need to
define a Search string.

New button Show all documents

• A new button Show all documents has been added to Document
manager. This button resets the document list so that all documents are
visible, and all searches and filtering are cleared. Excluded categories
remain excluded. This new feature also provides a convenient way to
restore the document list to a default state when recording macros.

Invert document visibility/Reset document visibility

Now when you activate the  Invert document visibility switch, the name
of the switch changes to Reset document visibility to indicate that clicking
the button again will reset the visibility and not invert the visibility a second
time.

Other Document manager improvements

• Document manager search box now supports macro recording and
playback.

1.11 Improvements in rebar drawing tools
Tekla Structures 2019i introduces some improvements in Rebar group
marking, Rebar pull-out picture and marking, and Rebar group
dimensioning.
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Rebar group marking
• The Rebar group marking application now works with circular rebar

groups.

• The Lines and symbol tab has new settings for drawing a symbol at the
intersection of distribution lines and leader lines. The functionality for
rebar symbols has been moved to the new Symbols on rebars tab.

• A new setting has been added on the Mark 1 tab to set the mark distance
from the leader line.

For more information, see Add reinforcement marks with Rebar group
marking application.
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Rebar pull-out picture and marking
• On the Dimensions tab, you can now select whether to round according to

the user settings or according to the rebar_config.inp.

• Rebar pull-out picture and marking no longer creates duplicate pull-out
pictures. The same fix was made in the Draw rebar pull-outs application.

For more information, see Draw rebar pull-out pictures with Rebar pull-out
picture and marking application.

Rebar group dimensioning
• A new Group dimensions setting was added on the Advanced settings

tab to control if dimensions are grouped or not. Grouping now works also
when the distance between the groups is zero.

• Invisible color can now be applied on rebar lines and symbols.

• Rebar group dimensioning now dimensions rebar groups in polybeams.

For more information, see Dimension rebars with Rebar group dimensioning
application.

1.12 Printing to multiple printers and other printing
improvements
Starting from Tekla Structures 2019i, you can print to more than one printer in
one go based on the paper size of each selected drawing. When printing to
multiple printers you typically have different printers for handling different
paper sizes. Tekla Structures automatically selects the appropriate printer for
each drawing.

For more information about printing, see Print to a .pdf file, plot file (.plt) or
printer.

Print drawings to multiple printers in one go

The Print Drawings dialog box now has a new control for printing to multiple
printers: Use multiple printers. When you want to print to a single printer, or
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define single printer settings to be used in multiple printing, select Use one
printer.

Create single printing settings

To print to multiple printers, you first need to create single printing settings for
each of the printers you want to print to:

• Select Use one printer, and define the printing properties as desired.
Select the output type and printer, and define the paper size that this
printer will handle in the Use multiple printers mode. Then give the
settings a unique name and click Save. Repeat this for each of the desired
paper sizes. Do not use the size option Auto.

For example, you can create the following single printer settings files with
the output type set to PDF file:

• PDF A4: Paper size set to A4, file prefix set to A4_
• PDF A3: Paper size set to A3, file prefix set to A3_
• PDF A2: Paper size set to A2, file prefix set to A2_

• When printing a set of drawings in the multiple printers mode using the
above single printer settings files, all A4 drawings will generate .pdf files
with prefix A4_, all A3 drawings will have prefix A3_, and all A2 drawing will
generate .pdf files with prefix A2_.

• If you want to print more than one sheet size to the same printer in the
Use multiple printers mode, create a single printer settings file for each
paper size, and specify the same printer in all of these files.
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Print to multiple printers

Change to the Use multiple printers mode, and in the Selected single
printer settings files list, select the settings files to use in printing. You can
select all or just some of the single printer settings files.
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The output type (printer, plot file, PDF file) is defined by each selected single
printer settings file. Typically you would select settings files with the same
output type. Output types lists the output types that are specified in the
selected single printer settings files.

Change other necessary settings. When the output type of the selected
settings files is Plot file or PDF file, you can change the following properties.
These settings cannot be changed if the output type is Printer:

• File location: Where to create the output files. If the selected settings files
specify a subfolder, then the output path is the combination of the main
path and the subfolder path, which allows each settings file to specify a
different subfolder. You can also specify an absolute path in each selected
settings file, which will override the main path.

Example:

Main path: .\Plotfiles
Settings file 1 subfolder path: A4
Output result for settings file 1: .\Plotfiles\A4\

• Include revision mark to file name

• File prefix: Each selected settings file can override this.

• File suffix: Each selected settings file can override this.

• Fit to paper

• Scale

• Center drawing on paper
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• Print on multiple sheets

• Orientation

• Number of copies

• Collate

• Note that you cannot change the paper size, it is already included in the
selected settings files. You can see the selected paper sizes listed in the
dialog box.

• You can also save the multiple printing settings to a settings file for future
use. Note that the multiple printing settings files are saved in the same
location as the single printer settings files (<model>\attributes) but with
a different file name suffix PdfMultiPrintOptions. For single printer
settings, the suffix is PdfPrintOptions. This ensures that the settings are
kept separate from the single printer settings.

• Click Print to print to multiple printers.

Other printing improvements
• The Print Drawings dialog box now displays a message in the status area if

it is not possible to print due to invalid printing settings.

1.13 Improvements in Tekla Model Sharing
Tekla Structures 2019i introduces several improvements regarding Tekla Model
Sharing. For example, reasons of write out failures are now stored in log files
to simplify troubleshooting, and pour management is more robust than ever
before.

Reasons of write out failures are stored in log files

If writing out model changes fails, the reasons for the failure are now saved in
the error log and the model sharing log.

In the error_<user>_<YYYYMMDD>_<HHMMSS>.log file, you can find the
reasons why Tekla Structures has failed to restore or save a file, or to write a
material report export file or profile export file.

In the modelsharing.log file, you can find the reasons why creating data in
the write out has failed. These errors can happen because of several reasons,
such as low disk space, database errors, or using a user role that does not
permit making certain changes.
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Improved pour management

Pour management in shared models has been improved significantly.
Unexpected conflicts have been addressed, so working with pour units is safer
and more efficient than ever before.

Earlier, pour management could cause conflicts when reading in other users'
changes, and as a result, objects in pour units might have been accidentally
removed.

Improved and more robust sharing operations
Sharing operations now work more reliably even when other software are
locking some of the files needed to perform the operations. For example, if a
file that is needed to create a packet is opened by anti-virus software, Tekla
Structures can still create the packet without errors.

1.14 Changes in Tekla Structures installation
Starting from Tekla Structures 2019 SP1, you can select in the environment
installation wizard that the environment .tsep files are installed when
running the installation wizard. If you do not select to install the .tsep files
automatically, the files are installed when you start Tekla Structures for the
first time after installation.

Note that if you are installing more than one environment for the first time, we
recommend that you install the .tsep files by starting Tekla Structures.

1.15 New structure of firm and project folders
You can now create user-defined sub-folders under the firm and project
folders and store property files in the sub-folders. This means that you can
have a more organized folder structure in the project and firm folders. Tekla
Structures can read and copy the property files from the sub-folders when
needed. For example, property files are copied when you start sharing a
model.

Note that property files cannot be read from the following pre-defined sub-
folders under the firm and project folders:

• ProjectOrganizerData
• ProjectOrganizerData\DefaultCategoryTrees
• ProjectOrganizerData\PropertyTemplates
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• ProjectOrganizerData\ExcelTemplates
• AdditionalIPSets
• macros

• macros\drawings
• macros\modeling

• Drawing Details
• extensions

• extensions\drawings
• extensions\model

• CustomInquiry
• PropertyRepository\Templates
• symbols
• template

• template\mark
• template\settings
• template\tooltips

• profil
• profil\ShapeGeometries
• profil\Shapes

• Environment folders

Tekla Structures searches for property files in the sub-folders of the firm folder
or the project folder as follows:

1. The search starts from the root folder (XS_FIRM or XS_PROJECT).

2. If Tekla Structures finds the first property file with a corresponding file
name suffix and file name prefix, the property file is selected.

3. The search continues so that each sub-folder of the root folder is
searched in alphabetical order.

4. Tekla Structures ignores each attribute file with the same file name suffix
and file name prefix as the previously selected file, and stores each file
name in the error log.

1.16 Interoperability improvements
Tekla Structures 2019i contains improvements in reference models, IFC object
conversion, IFC export, and point cloud functionality.

Tekla Structures 2019i release notes 54 Interoperability improvements



Reference models

Reference model object locking

• Reference model objects can no longer be locked. Locking prevented
model update, caused confusion and increased the size of the database.
Object lock has been used for locking model location. We recommend that
you use model lock instead and set 
XS_REFRESH_ALSO_LOCKED_REFERENCE_MODELS to TRUE.

For more information about locking reference models, see Lock reference
models.

.db1 as reference model format

• The .db1 format has been removed from the supported reference model
formats. You can still enable the .db1 format in the Add model dialog box
by setting the advanced option
XS_ENABLE_NATIVE_MODEL_AS_REFERENCE_MODEL to TRUE in an .ini
file. Originally, this format was added in the Add model dialog box for
testing purposes.

Calculate new offsets when Location by is changed

• Reference model Location by change logic has been improved. By default,
the location by change does not keep the reference model location. A new
check box was added to calculate new offsets and keep the current
reference model location.

New reference model template attributes

• Reference model properties Code, Title, Phase, Description and Group
are now available as template attributes for reports.

Other reference model improvements

• When you refresh reference models that have been created with previous
versions of Tekla Structures, the reference model information is now
updated to match the version of Tekla Structures that you are currently
using.

• The performance of the reference model insert has been improved when
the Tekla Structures model already contains non-visible unloaded reference
models. After the fix, non-visible reference models are not loaded anymore
in the reference model insert.

• Now it is possible to use 3D image files (.obj) as reference models.
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IFC object conversion
• IFC object conversion of steel contour plates now uses the prefix defined

for plates in Components settings ( File --> Settings --> Options --> Profile
name --> Plate ) as the prefix for Tekla Structures native plates. You can
use prefixes that are supported by your environment.

• Arbitrary profile mapping by name does not need to match the
dimensions. Arbitrary profile mapping by name can be set to require
dimensions to match by setting the new advanced option 
XS_CONVERSION_ARBITRARY_PROFILE_MAPPING_BY_NAME_MUST_MATCH
_DIMENSIONS to TRUE. The default is FALSE.

• Parametric profile conversion by profile name mapping does not need to
match the dimensions. Parametric profile conversion tries to find a
corresponding library profile and if a profile does not match the
parameters, the default parametric profile will be used.

For more information, see Convert IFC objects into native Tekla Structures
objects.

IFC export

IFC2x3 export

• You can now also export radial grids in the IFC2x3 export.

• Edge chamfers are omitted from the exported IFC model. This is to enable
better interoperability with plant design systems. If the geometry with edge
chamfers is needed, you can set the IFC export type to B-rep separately for
those objects in the objects' user-defined attributes dialog box on the IFC
export tab.

IFC4 export

• The IFC4 Export now contains a new export type IFC4precast view. The
IFC4precast view aims to support the fabrication data transfer workflow of
precast elements. At the first phase it covers the fabrication of precast
walls and slabs including all the needed reinforcement and embeds.

For more information, see Export a Tekla Structures model or selected model
objects to an IFC file and IFC4precast.
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Point clouds
• You can now use point clouds through internet. There is a new URL option

in the Attach point cloud dialog box where you can enter the URL
address.

• Point cloud web streaming cache has been added. The cache is a common
cache with Trimble Connect for Desktop. You can define the cache folder
using the advanced option XS_POINT_CLOUDS_WEB_CACHE in the File
Locations category of the Advanced Options dialog box. The cache usage
improves the performance of the web streamed point clouds.

For more information, see Point clouds.

1.17 Export to 3D DGN v8 - New 3D DGN export
The 3D DGN export has been renewed.

The new 3D DGN v8 uses Teigha libraries and has some new features:

• The 3D DGN export now has the requested v8 format, and base point
functionality.

• There are several new export settings available in the new 3D DNG v8
export. In the old 3D DGN export, you could only define the export file
name and location, and select whether to export all objects or selected
objects.

• The surface presentation of the parts is exported. Bolt holes are not
included in the export.

• You can now export objects relative to the model origin, to the base point
you define, or to the work plane.

• You can now export in layers by name, phase or any template attribute or
user-defined attribute.

• Colors can be exported by class or by stored object representation.
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• You can export all objects or selected objects. You can use the Select parts
and Select objects in components selection switches for selecting the
objects to export.

• The old 3D DGN v7 export is still available in File --> Export --> 3D DGN .

Create object group color representations
If you want to use object group color representations in the export, you need
to create the object groups first and then set the colors for the object groups.
Note that the transparency setting is not included in the export.

For more information, see Create object groups, and Change the color of an
object group.

Create base points
If you want to export objects relative to a base point, you need to create a base
point in your model. For more information, see Base points.

Export to 3D DGN v8
• To start the export, go to the File menu, and click Export --> 3D DGN v8 .

• Define the file name and folder.

• In Location by, select whether you want to export by model origin, by work
plane, or by a defined base point.

• Select All objects or Selected objects.
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• If you want to export selected objects, select the objects with the
appropriate selection switches:

• If you activate the parts selection or the objects in components
selection, all the selected parts will be exported.

• If you activate the assembly selection, nothing will be exported.

• If you activate the component selection, nothing will be exported.

• In Object color, select whether you want to export objects using object
class colors or object group colors. You can use phases, part names, or
template attributes as layer names for exported objects. Select Name or
Phase from the list, or type the attribute name in the box. You can also use
user-defined attributes as a layer name.

• When you are done, click Export to export the objects according to the
defined settings.

• For more information about the export, see Export to 3D DGN.

1.18 Export to 3D DWG - New 3D DWG export
The 3D DWG export has been renewed.

The new 3D DWG uses Teigha libraries and has some new features:

• The 3D DWG export now has the base point functionality.

• There are several new export settings available in the new 3D DWG export.

• The surface presentation of the parts is exported. Bolt holes are not
included in the export.

• You can now export objects relative to the model origin, to the base point
you define, or to the work plane.

• You can now export in layers by name, phase or any template attribute or
user-defined attribute.

• Colors can be exported by class or by stored object representation.

• You can export all objects or selected objects. You can use the selection
switches for selecting the parts or objects in components to export.

• The old 3D DWG/DXF export is still available in File --> Export --> 3D
DWG/DXF .
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Create object group color representations
If you want to use object group color representations in the export, you need
to create the object groups first and then set the colors for the object groups.
Note that the transparency setting is also included in the export.

For more information, see Create object groups, and Change the color of an
object group.

Create base points
If you want to export objects relative to a base point, you need to create a base
point in your model. For more information, see Base points.

Export to 3D DWG
• To start the export, go to the File menu, and click Export --> 3D DWG .

• Define the file name and folder.

• In Location by, select whether you want to export by model origin, by work
plane, or by a defined base point.

• Select All objects or Selected objects.

• If you want to export selected objects, select the objects with the
appropriate selection switches:

• If you activate the parts selection or the objects in components
selection, all the selected parts will be exported.

• If you activate the assembly selection, nothing will be exported.
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• If you activate the component selection, nothing will be exported.

• In Object color, select whether you want to export objects using object
class colors or object group colors. You can use phases, part names, or
template attributes as layer names for exported objects. Select Name or
Phase from the list, or type the attribute name in the box. You can also use
user-defined attributes as a layer name.

• When you are done, click Export to export the objects according to the
defined settings.

• For more information about the export, see Export to 3D DWG or DXF.

1.19 Updates in tools for concrete fabrication
Export Unitechnik (79), Export EliPlan file, and Export BVBS contain several
improvements.

Export Unitechnik (79)
Export Unitechnik (79) has been improved in the following ways:

• The settings Name of order and Drawing number on the HEADER block
data specification tab and Slab number on the SLABDATE block data
specification tab now have a new option File name sections. Select this
option and specify a string consisting of numbers referring to the 6
sections of the exported file name mask that are specified on the Main tab.
You can type numbers 1 to 6, and delimiters , . _ and - in the free input field
to export any combination of strings used in the file name, in any order.
For example, 1-2-3, or 2_5_6. Use this option to ensure that both the strings
in the file name and within the file content match the expected project and
drawing numbers for successful file import.

• When using file name block options it is now possible to specify input text
without delimiters.

• Main tab:

• It is now possible to use a selection filter to select the parts for export
with the new Export using filter setting. You can use the selection filter
for including or excluding the parts from the export.

• SLABDATE block data specification tab:

• It is now possible to export the unloading type using the new
Unloading type setting. Also, it is possible to set Unloading type and
Transport type on the Unitechnik tab for precast concrete parts,
which overrides the export dialog box setting.

• It is now possible to specify a user-defined concrete volume template
property for export using the Concrete volume setting.

Tekla Structures 2019i release notes 61 Updates in tools for concrete fabrication



• There is a new option for the Export project coordinates setting. Use
the new Yes, special variant A option to export Unitechnik files that
are compatible with the IDAT stacker software. The new option is only
available for the 5.2b version of Unitechnik.

• Pallet tab:

• A Profile centerline to pallet centerline option has been added for
the Align in Y axis . With the Profile centerline to pallet centerline
option, you can automatically align hollow-core slabs to the center of
the pallet in Y direction.

• Validation tab:

• A new option Exclude all has been added for the setting Export others
to exclude the whole mesh from the export when it fails the validation.
The option No has been renamed to Remove invalid mesh wires, and
now this option only excludes invalid mesh wires and not the whole
mesh when some of the mesh wires fail the validation.

• TS configuration tab:

• New settings have been added on the TS configuration tab. The
Rotate geometry setting applies the rotation angle calculated with the
settings Extra rotation and Auto-rotate on pallet. The With
SLABDATE rotation angle setting rotates the element and exports the
rotation angle as a value in the respective SLABDATE field.

• The Extend contour and add formwork option has been improved in
situations where the contour needs to be extended into the -X or -Y
direction.

For more information, see Unitechnik.

Export EliPlan file
Export EliPlan file has been improved in the following ways:

• It is now possible to specify a selection filter using the setting Export using
filter on the Parameters tab. The parts are selected on the basis of the
specified selection filter.

• Plotter data export has been improved.

For more information, see EliPLAN.
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BVBS Export
BVBS Export has been improved in the following ways:

• The BVBS export now reports the diameter value as the nominal rebar
diameter regardless of the XS_USE_ONLY_NOMINAL_REBAR_DIAMETER
setting, according to the specification.

• The Partner and Developer configurations were added to the list of allowed
configurations.

• Parameters tab:

• You can now use multiple assembly template properties in the file
name. Type the template properties in the File naming template box
and separate them with spaces. The combination will be separated by
underscores in the exported file name.

• The Drawing name source setting has a new option Assembly
template, and the Template option has been renamed to
Reinforcement template.

• Checking tab:

• Check cutting length has been renamed to Check reinforcement, and
new checking options have been added:

- Reinforcement diameters (separated with spaces)

- Minimum leg length for straight sections between the bends

- Maximum weight of individual bars

• Advanced tab:

• Click the Edit or New button under Private data block. The list of
property data types has been updated, and the following options are
now available:

- Reinforcement report property Integer, Float or Text

- User-defined attribute Integer, Float or Text

- Open API object property

- Assembly report property Integer, Float or Text

• You can now move up, move down, edit and remove private data block
export items.

• BVBS Export now contains new options for rounding rebar lengths for
2D bent bars. Mesh and 3D rebars are not affected.

To round the lengths, first select an option for the Round setting. The
options are:

YesUp - Uses the nearest rounding value.

Up - Rounds the lengths up.

Down - Rounds the lengths down.
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The new option Round lengths to rounds the total rebar lengths in the
corresponding BVBS field in the header block, and the available values
are 1, 5, 10, and 25.

The new option Round leg lengths to rounds the leg lengths in the
geometry block, and the available values are 1, 5, and 10. 1 is the
default value for both options.

For more information, see BVBS.

1.20 Improvements in components
There are several improvements in concrete components and steel
components in Tekla Structures 2019i.

Concrete components

  
Rectangular area
reinforcement (94)

You can use the new Rectangular area reinforcement
(94) component to reinforced rectangular areas. You
can create column and beam section reinforcement
to the inside of a wall or a slab.

Select the part where the reinforcement is placed and
pick two points to create the reinforcement. The part
defines the thickness of the reinforced area, and the
two points define the geometry and the location of
the reinforced area.

Automated
reinforcement
layout - Double tee
beam (51)

On the Strand profile tab, a new option has been
added to depress the strand in 3 positions instead of
2 positions.

Pad footing
reinforcement (77)

You can now define custom hooks for the primary
and secondary rebars.

Round column
reinforcement (82)

• On the Main bars tab, you can now define the
horizontal dimensions of the top and bottom
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cranked bars as a distance between the center of
bars or as the outer distance of bars.

• On the Advanced (main bars) tab, you can now
select whether the main bars are created as a
rebar group or as single rebars.

Braced girder (88),
Braced girder (89)

There are now two new girder shapes available.

Rebar in beam (90) On the Stirrups, Stirrups 2 and Stirrups 3 tabs, you
can now select in Create stirrups whether stirrups
are created As separate groups or As one group.
Define the stirrup group spacings for the separate
groups on the stirrup spacing tabs.

Reinforced concrete
stair (95)

• The stairs part now has a new 
STAIR_WIDTH_TOTAL UDA that counts the total
stair width including the stringers.

• For bar type H, you can now set the name, class,
prefix and start number separately for the top and
bottom rebar.
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• You can now enter a comment in the Comment

box for all types of rebars that the component
creates.

• On the Stairs and landings tab, you can now
create openings or recesses (screed tray) in the
bottom or the top landing.

The rebars defined on the following tabs
automatically avoid the openings created by these
new opening/recess options: Bottom anchor
bars, Top anchor bars, Z anchor bars, Mesh
bars (top/bottom), Bar A, Bar B, Bar C, Bar E, Bar
G, Bar K, and Landing end bars (bottom/top).

Concrete console
(110), Concrete
console (111)

On the Connection tab (Concrete console (110)) and
Anchor tab (Concrete console (111)), you can now
enter 79 characters in the Tube bottom Comment
box. Previously, you could only enter 19 characters.

Note that due to this change, the components and
property files created with older Tekla Structures
versions may have incorrect content in the
Comments of Tube bottom and Washers. We
recommend that you check and update your property
files.

Floor layout • On the Advanced tab, you can now use the
Create cut-outs option to control whether the
cut-outs (notches or openings) are created for the
slabs. If you set the option to No, the slab is
created without any cuts. Slabs at break lines or
openings which are cut at the whole width are still
split and created as two or more slabs.

Note that the other options on the Advanced tab
related to the minimum slab width/neck width still
control whether the slab is created/split or not.

You can create automatic cut-outs for parts
penetrating the floor layout areas by entering up
to three lists of part classes or names.

• On the General tab, you can now select to create
slabs and parts by default part width or maximum
part width, or the number of parts.

• You can now enter a negative value for the break
line offset on the Default offset tab.

Wall layout You can now use the Copy special > Mirror and
Move special > Mirror commands to mirror wall
layouts.
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Wall panel
reinforcement

• On Picture tab, there is now a minimum bar
length option that you can use for filtering rebars
smaller than the defined length.

• On the Picture tab, you can now define the top
and bottom extra offset.

Double wall edge
and opening
reinforcement, Wall
panel reinforcement

You can now define the type of door and notch
reinforcement on the new Door and Notch tabs.

Sandwich and
double wall

• On the Parts tab, there is now a new material
definition option for insulation, Edge strips in
split case, which can be used to define a different
material for the insulation parts that are on the
edge of the wall.

• On the Parts tab, you can now set the cast unit
type of the inside shell, insulation, and outside
shell. Set the Cast unit type to Enabled to do this.

• On the Vertical section tab, there is a new option
for creating concrete all over the top surface.

In the list of thicken innershell options, select

to cover the insulation and the outer shell.
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Sandwich wall
horizontal seam

On the Rabbets tab, you can now select a tongue or
groove joint connection for both sides of the
sandwich wall. If you create one tongue and one
groove connection, it is possible to have the parts
overlap.
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Mesh bars/Mesh
bars by area

• When detailing without grid on the Detailing tab,
you can now select whether the distances are the
same or different for the top and bottom bars.
Using different distances helps in placing top and
bottom hooks so that they do not collide, for
example.

• When defining the Spacing type on the Picture
tab, you can now select to set the spacing by exact
spacings. List the distances between the bars in
the Spacing box.

Steel components

  
Base plate (1004),
Stiffened base plate
(1014), U.S. Base plate
(1047), Joining plates
(14), Stiffened end plate
(27), Partial stiff end
plate (65), Two sided
end plate (142), End
plate (144)

It is now possible to create two new types of shim
plates where the shim plate is created as two
separate plates divided horizontally or vertically
with the corresponding slots.
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Tube crossing (22) On the Brace conn tab, you can now define a gap
between the gusset and the connection plates.

Tube gusset (20), Tube
crossing (22)

On the Brace conn tab, you can now to set the
position of the middle end plate.

Shear Pl to tube column
(47)

• You can now define the bolt properties
separately for the primary and secondary
bolts.

• You can now define the radius of the top and
bottom beam cut on the Primary and
Secondary tabs.
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Purlin 1 (61) On the Bolts tab, you can now select from the

Slots in list the parts in which slotted holes are
created.

Partial stiff end plate
(65)

You can now define the distance between an L
profile end and the top of the main part.

Railings (S77) You can now define separate position and rotation
settings for the top and bottom rails on the Rails
tab and for the middle rails on the Middle Rails
tab.

Bridging (80) There are now 4 new bridging types available on
the Parameters tab: Stratco, Safebridge,
Metroll, and Steel and Tube.

End plate (101) You can now align the end plate with the
secondary part slope using the Adapt to
secondary part slope option on the End plate
tab.

Stub connection (119) You can now set the thickness, material and name
separately for the top, back and middle stiffeners
on the Parts tab.

Full depth (184), Column
with stiffeners (186),
Column with stiffeners
(188)

On the Plates tab, you can now select whether
the shear tab is cut parallel to the main part web.

JP Full depth special
(185)

You can now define the inner shear tab chamfers
and the chamfer dimensions on the Plates tab.
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Stiffeners (1003) • You can now rotate the stiffener polygons on

the Parameters tab. You can set the rotation
for both the right and the left stiffener.

• You can now define the stiffener plate distance
from the beam flange on the Picture tab.

Stiffened base plate
(1014)

You can now select to create two grout holes on
the Parameters tab.

Doubler plate (1022) You can now use separate settings for horizontal
and vertical welds.

Stiffeners (1034) It is now possible to create a weld between the
bottom flange of the main part and the stiffener
plate using weld 2, and a weld between the top
flange of the main part and the stiffener plate
using weld 3.
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1.21 Changes in advanced options

New advanced options
• XS_REBARSET_SHOW_GUIDELINES

• XS_REBARSET_SHOW_MODIFIERS_CREATED_BY_COMPONENTS

• XS_REBARSET_CREATION_ANGLE_TOLERANCE_FOR_LONGITUDINAL_
REBARS

• XS_REBARSET_CREATION_ANGLE_TOLERANCE_FOR_CROSSING_REBARS

• XS_REBAR_MINIMUM_LEG_DEVIATION

• XS_REBAR_COMBINE_BENDINGS_IN_EVALUATOR

• XS_CONVERSION_ARBITRARY_PROFILE_MAPPING_BY_NAME_MUST_MATCH_
DIMENSIONS

• XS_MARK_LEADER_LINE_LENGTH_FOR_PERPENDICULAR

• XS_POINT_CLOUDS_WEB_CACHE
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2 Tekla Structures 2019i
administrator's release notes

Upgrade guide from Tekla Structures 2019 to Tekla Structures 2019i

Administrator's release notes are intended to provide advanced users with
instructions on how to apply the additional customizations available in a new
Tekla Structures version.

Administrator's release notes: General settings (page 74)

Administrator's release notes: Steel settings (page 101)

Administrator's release notes: Concrete settings (page 102)

2.1 Administrator's release notes: General settings
General customization settings apply to all user groups. Use these settings
together with your own user group settings.

Administrator's release notes: Model templates in version update (page 75)

Administrator's release notes: Applications & components catalog
maintenance (page 78)

Administrator's release notes: New structure of firm and project folders
(page 79)

Administrator's release notes: Lofted plate and lofted slab (page 81)

Administrator's release notes: UDA handling in the property pane (page 82)

Administrator's release notes: Multiple printing settings (page 94)

Administrator's release notes: Improvements in drawings (page 94)

Administrator's release notes: Improvements in marks (page 96)

Administrator's release notes: Interoperability improvements (page 99)
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Administrator's release notes: Model templates in version
update
1. Open Tekla Structures 2019i.

2. Create a new model using an existing model template.

3. Give the model the same name as in the previous Tekla Structures
version.

4. Open a 3D view.

5. Diagnose and repair the model.
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6. Create a project thumbnail, or add a custom image named
thumbnail.png in the model folder.

The preferred size of the image is 120 x 74 pixels.
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7. Save the model.

If you do not do this, a message may appear warning about the model
being created with a previous version.

8. Save the model as a model template.

9. Include the needed catalog files and subfolders from the model folder,
and click OK.

10. Remove manually all *.db files (environment database, options
databases) from the model folder.
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The *.bak, *.log and xs_user files are automatically removed from the
model folder.

The .idrm files (db.idrm and xslib.idrm) should be kept as they are
part of the model.

The model template is saved in a location pointed by 
XS_MODEL_TEMPLATE_DIRECTORY.

You now have a sample image for your model template. The Applications
& components catalog is now also in order and easy to use.

Administrator's release notes: Applications & components
catalog maintenance
Keep the Applications & components catalog in shape and usable. For more
information about the Applications & components catalog, see How to use
the Applications & components catalog.

Set XS_COMPONENT_CATALOG_ALLOW_SYSTEM_EDIT to TRUE to be able to edit
the Applications & components catalog definition files that are located in the 
XS_SYSTEM folders.

Check and fix the following:

1. Add the items to groups

Check Ungrouped items and add the items to the appropriate group.

2. Check the logs for errors
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The Applications & components catalog shows the message log  button
in the lower-right corner of the catalog if there are errors or warnings in the
catalog definition files, for example.

If there are references to missing plug-ins, go to the referred
ComponentCatalog.xml and remove the references manually:

Test thoroughly that these changes do not create any further errors, or change
the structure of your Applications & components catalog. Check at least the
Ungrouped items and Legacy catalog groups.

As in the example above, there may be errors for:

• CatalogPluginComponentItem?CopyModelDirectoryPlugin
• CatalogPluginComponentItem?SaveAsModelTemplatePlugin
3. Hide all non-related applications and components from roles

1. In the Ungrouped items catalog, select the Show hidden items check
box at the bottom.

2. Right-click an application or a component and select Hide / Unhide.

4. Create custom thumbnails

Publish a component in the Applications & components catalog

You may need to use the same component with different settings in different
cases. To easily use the component, you can define the settings for each case
and publish the component in the catalog. This feature can be useful for some
roles.
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Administrator's release notes: New structure of firm and
project folders

You can now create user-defined sub-folders under the firm and project
folders and store property files in the sub-folders. This means that you can
have a more organized folder structure in the project and firm folders. Tekla
Structures can read and copy the property files from the sub-folders when
needed. For example, property files are copied when you start sharing a
model.

Note that property files cannot be read from the following pre-defined sub-
folders under the firm and project folders:

• ProjectOrganizerData
• ProjectOrganizerData\DefaultCategoryTrees
• ProjectOrganizerData\PropertyTemplates
• ProjectOrganizerData\ExcelTemplates

• AdditionalIPSets
• macros

• macros\drawings
• macros\modeling

• Drawing Details
• extensions

• extensions\drawings
• extensions\model

• CustomInquiry
• PropertyRepository\Templates
• symbols
• template

• template\mark
• template\settings
• template\tooltips

• profil
• profil\ShapeGeometries
• profil\Shapes

• Environment folders

Tekla Structures searches for property files in the sub-folders of the firm folder
or the project folder as follows:
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1. The search starts from the root folder (XS_FIRM or XS_PROJECT).

2. If Tekla Structures finds the first property file with a corresponding file
name suffix and file name prefix, the property file is selected.

3. The search continues so that each sub-folder of the root folder is
searched in alphabetical order.

4. Tekla Structures ignores each attribute file with the same file name suffix
and file name prefix as the previously selected file, and stores each file
name in the error log.

Administrator's release notes: Lofted plate and lofted slab
Tekla Structures 2019i introduces new part types: steel lofted plate and
concrete lofted slab. Use lofted plates to model rolled plates and plates with
double-curved form, for example. Use lofted slabs to model curved and
double-curved slabs or walls, for example.

For more information, see New part types: lofted plate and lofted slab
(page 22)

Lofted plate

Current configuration in the common environment
...\2019.1\Environments\common\system\standard.lpl
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Lofted slab

Current configuration in the common environment
...\2019.1\Environments\common\system\standard.lsl

To do

Create new settings and save them. The new settings files can be found from:

\<model>\attributes\<SettingName> - lsl.

\<model>\attributes\<SettingName> - lpl.

Save the files to the wanted folder in the XS_SYSTEM path.

The files will be searched from XS_PROJECT, XS_FIRM, XS_DRIVER, 
XS_SYSTEM and XS_USER_SETTINGS_DIRECTORY.
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Administrator's release notes: UDA handling in the
property pane
Tekla Structures 2019i introduces improvements in the property pane and the
Property pane editor. With these updates, especially the viewing and
modifying of user-defined attributes (UDAs) is now easier and more
straightforward.
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For more information, see Updates to the property pane, UDAs, and to the
Property pane editor (page 11).

To do

Configure the wanted area-specific UDAs to the property pane. You can select
to add them all or just the most commonly used UDAs.
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The customized settings files can be found from: ..\Users\<user>\AppData
\Local\Trimble\Tekla Structures\<version>\UI
\PropertyTemplates\PropertyTemplates.xml.

Move the file to the wanted folder in the XS_SYSTEM path ...
\PropertyRepository\Templates\.

Note

The property pane searches the configuration files from the model folder, and 
XS_PROJECT, XS_FIRM, XS_DRIVER, and XS_SYSTEM folders.

Groups that are defined in different PropertyTemplates.xml files are not
merged for object types. However, if the property template in a higher priority
folder does not contain any definition for an object type, the definition in a
lower priority folder will be used for that object type. Merging does not work
within object types but it works between object types.

If the file exists in ..\Users\<user>\AppData\Local\Trimble\Tekla
Structures\<version>\UI\PropertyTemplates\, it will be used.

Set default values automatically -option

Set default values automatically option is under the Visibility of properties
button. The default status of the option is checked and Modify button works
as before. When it is unchecked, Set as default button will be visible in
property pane and works as the old Apply button. In this state, the Modify
button does not automatically apply the edited properties for the next object
creation.

This is also possible to configure in the PropertyTemplates.xml file.
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Localization tasks
The aim is to have good UDA grouping for all available UDAs within each role,
and to choose which carefully chosen groups should be visible by default in
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each role. The result should be clean, practical and easy-to-understand,
without reporting any warnings to user due to missing UDAs.

We recommend that you create the grouping in line with the content of UDA
tabs but this is a great opportunity to streamline them and sub-categorize
them to improve the user experience.
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Which environments and roles need to be localized

• The PropertyTemplates.xml files for an environment need to be
updated if the environment contains environment-specific UDAs.

• The PropertyTemplates.xml file for a role needs to be updated if the
role contains role-specific UDAs.

PropertyTemplates.xml files to be used as a starting point

The common environment contains four property template files with UDAs
defined in the common environment. When starting to localize your property
templates, you can use them as a starting point.

Known issues with the property templates:

• Grid UDAs cannot currently be added to the property pane

• All group titles do not have a translation yet

Steps to localize the property templates

1. Remove the existing PropertyTemplates.xml files from the
environment so that they do not interfere with the new files you are
creating.

2. Start Tekla Structures with the role for which you want to localize, or the
role with most UDAs if you are creating only one property template for an
environment.

3. Set XS_ENABLE_POUR_MANAGEMENT to TRUE to see pour UDAs.

4. Select the best matching property template for your role/environment to
use it as a starting point:

Template in folder UDAs in template
Common Parameters, User fields, Product

information, Structural information,
End conditions, Analysis, Tekla
Structural Designer, IFC export,
Unitechnik (for rebars), Couplers

ConstructionManagement All above + Workflow UDAs
CIP All above + BVBS UDAs
Precast All above + Unitechnik (for parts),

EliPlan, HMS UDAs

5. Store the selected PropertyTemplates.xml file to the ..\Users
\<user>\AppData\Local\Trimble\Tekla Structures\<version>
\UI\PropertyTemplates folder.
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6. Open Property pane editor.

7. For each object type, do the following:

a. Check which UDA tabs are available in the old UDA dialog box.
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b. Add groups corresponding to the tabs in property pane. You can
divide the tabs into several groups if needed.
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c. Add the UDAs on each tab to the corresponding group in the property
pane. Note! Copy the tabs with the Copy properties command for
object types that have the same tabs.
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d. Remove any UDAs that are not available in the role, as they will
otherwise be reported as missing.

e. If you had a group Custom properties in your property template,
rename it as More.

f. Hide other than the most frequently used groups by clicking the eye
icon in Property pane editor. This ensures that the property pane
only shows the content that you need.

g. Add labels for UDAs with the Rename command if the labels have
been defined separately from the UDA in the objects.inp file.
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h. Translations that exist in joints.ail or in another file in the
messages folder can be used by typing translation:x_x_xx to the
edit label Rename dialog box.

8. When ready, move the PropertyTemplates.xml file from ..\Users
\<user>\AppData\Local\Trimble\Tekla Structures\<version>
\UI\PropertyTemplates to the \PropertyRepository\Templates
subfolder in the environment or environment\role folder. Ensure that no
property template remains in your \AppData folder, because the file in
the \AppData folder has the highest priority.

9. Open the property pane to test your property template.

The closest matches between the roles in the Default environment and the
example property templates:

Role Property template
CIP role CIP property template
Precast role Precast property template
Engineering role Precast property template
Steel role Construction management property template

NOTE Groups that are defined in different PropertyTemplates.xml files
are not merged for any specific object type. However, if a property
template in a higher priority folder does not contain any definition for
an object type, the definition in a lower priority folder will be used for
that object type. So merging does not work within object types but
between object types it works.

NOTE If the file exists in ..\Users\<user>\AppData\Local\Trimble
\TeklaStructures\<version>\UI\PropertyTemplates\, it will
be used in property pane.

Any changes will only be saved to the file in your user data folder.
Therefore, copy the environment file to be edited to the ..\Users
\<user>\AppData\Local\Trimble\Tekla Structures
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\<version>\UI\PropertyTemplates folder to ensure that all
changes are included in this one file. If you need to re-edit the file
later, copy the environment file again to the user data folder.

NOTE If your role is using a shared folder that is listed on the left side of the
role-specific folder in the XS_SYSTEM path, ensure that there is no
property template in that shared folder. Otherwise, the shared
property template will override your role-specific property template,
because folders on the left have higher priority.

As mentioned, the files do not merge within an object type, so the
folder path with highest hierarchy will override the other property
templates, which ensures there will not be any mismatch due to roles.
However, All roles might be missing UDA grouping for UDAs from
lower-ranking roles.

Administrator's release notes: Multiple printing settings
You can print to more than one printer in one go based on the paper size of
each selected drawing. You typically have different printers for handling
different paper sizes. Tekla Structures automatically selects the appropriate
printer for each drawing.

To do

Create the new settings and save them. The new
PdfMultiPrintOptions.xml settings file can be found from \<model>
\attributes\<SettingName>.

Save the file to the wanted folder in the XS_SYSTEM path.

The file will be searched from XS_PROJECT, XS_FIRM, XS_DRIVER, 
XS_SYSTEM, and XS_USER_SETTINGS_DIRECTORY folders.

For more information about the new option to print to multiple printers in one
go, see Printing to multiple printers and other printing improvements
(page 48).

Administrator's release notes: Improvements in drawings
You can now set the Fit by parts option for section views also before creating
the drawings. There are also improvements in rebar drawing tools.

Cast unit drawing creation
• In the drawing properties for section views, it is now possible to select Fit

by parts as an option to be used for the created section views.
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Improvements in rebar drawing tools

Rebar group dimensioning

A new Group dimensions option has been added to the Advanced settings
tab for controlling if dimensions are grouped or not. Grouping now works also
when the distance between the groups is zero.
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Rebar group marking

• There is a new feature that adds symbols on the distribution and leader
line intersection. To add this feature, the Lines and symbol tab is now
divided into 2 separate tabs.

• There is a new option on the Mark 1 tab to determine the offset from the
mark to the leader line.

For more information about improvements in rebar drawing tools, see
Improvements in rebar drawing tools (page 46).

Administrator's release notes: Improvements in marks
There are new options for rebar group marks. We also recommend that you
change the leader line default option for merged marks.

Merge marks

Currently, there is an option One leader line to group that shows only one
leader line. This could cause a misunderstanding because the mark is pointing
to only one object in the group instead of all. This is difficult to notice because
the merge functionality is automatic. Any other option adds leader lines to all
objects in the group.

For detailed instructions on how to merge marks, see Merge marks.
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Examples

One leader line to group

Parallel leader lines
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Leader lines to one point

To do

Localize the merged marks property to some other value than One leader
line to group.

• Drawing setting files (.ad, .wd, .cud, .gd)

• View setting files (.vi, .vpm, .vsm)

• Mark setting file (.pm)

Perpendicular leader line / Leader line to first and last
• There is a new type of leader line for group rebar marks: Leader line to first

and last.

• There is a new advanced option for perpendicular leader line length:

XS_MARK_LEADER_LINE_LENGTH_FOR_PERPENDICULAR
The XS_MARK_LEADER_LINE_LENGTH_FOR_PERPENDICULAR advanced
option now controls the leader line length in a similar way as the leader line
extension length controlled by 
XS_MARK_LEADER_LINE_EXTENSION_LENGTH.
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Administrator's release notes: Interoperability
improvements

Export to 3D DWG settings

Standard file in the common environment

The standard file can be found in C:\ProgramData\Trimble\Tekla
Structures\2019.1\Environments\common\system
\standard.dwgExport.json.

Tekla Structures 2019i administrator's release
notes

99 Administrator's release notes: General settings



For more information about the new 3D DWG export, see Export to 3D DWG -
New 3D DWG export (page 59).

To do

Create new settings and save them. The new dwgExport.json settings file
can be found in \<model>\attributes\<SettingName>.

Save the file to the wanted folder in the XS_SYSTEM path.

The file will be searched from XS_PROJECT, XS_FIRM, XS_DRIVER, 
XS_SYSTEM, and XS_USER_SETTINGS_DIRECTORY.

Export to 3D DGN settings

Standard file in the common environment

The standard file can be found in C:\ProgramData\Trimble\Tekla
Structures\2019.1\Environments\common\system
\standard.dgnExport.json.
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For more information about the new 3D DGN export, see Export to 3D DGN v8
- New 3D DGN export (page 57).

To do

Create new settings and save them, if needed. The new dgnExport.json
settings file can be found in \<model>\attributes\<SettingName>.

Save the file to the wanted folder in the XS_SYSTEM path.

The file will be searched from XS_PROJECT, XS_FIRM, XS_DRIVER, 
XS_SYSTEM, and XS_USER_SETTINGS_DIRECTORY.

2.2 Administrator's release notes: Steel settings
The following customization settings only apply to the steel user group.

Administrator's release notes: Steel components (page 101)

Administrator's release notes: Steel components
There are several improvements in steel components in Tekla Structures 2019i.

Update your standard files if you want to take the new options and features
into use.

For more information about these improvements, see Improvements in
components (page 64) in Tekla Structures 2019i release notes.
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2.3 Administrator's release notes: Concrete settings
The following customization settings only apply to the concrete user group.

Administrator's release notes: Rebar sets and other reinforcement
improvements (page 102)

Administrator's release notes: Updates in tools for concrete fabrication
(page 104)

Administrator's release notes: Concrete components (page 104)

Administrator's release notes: Rebar sets and other
reinforcement improvements
In Tekla Structures 2019i, there are many new features related to rebar sets,
and improvements in Rebar shape manager.

For additional information about these improvements, see also Improvements
in rebar sets and Rebar shape manager (page 32) in Tekla Structures 2019i
release notes.

Cranking using end detail modifiers

To do

Ensure that your environment's rebar database (rebar_database.inp) is
localized to cover the standard lapping and standard cranking functionalities.

Standard file update

Update your environment's end detail modifier standard file
(standard.rst_edm):

1. Create a rebar set. Interrupt the command. Then select the rebar set.

2. Create an end detail modifier. Interrupt the command. Then select the
end detail modifier.

The property pane opens.

3. Enter suitable standard values and save the file as standard.

4. Upload the newly created standard file again to your environment.

Face-specific concrete covers

To do

New standard file
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If needed, create a new surface object standard file and add it to your
environment (for example, Concrete cover.srfo and Concrete
cover.srfo.more):

1. Create a surface object. Interrupt the command. Then select the surface
object.

The property pane opens.

2. Enter suitable standard values and save the file as Concrete cover or
similar.

3. Upload the newly created standard file again to your environment.

Manual grouping

To do

Standard file update

Update your environment's property modifier standard file
(standard.rst_pm):

1. Create a rebar set. Interrupt the command. Then select the rebar set.

2. Create a property modifier. Interrupt the command. Then select the
property modifier.

The property pane opens.

3. Enter suitable values and save the file as standard.
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4. Upload the newly created standard files again to your environment.

Report template update

Update your report templates to support this new functionality. Use the
following updated templates from the Default environment (\default
\Concrete\Shared\ReportsAndTemplates) as an example:

• Rebar - Group Bending List - Compact.rpt
• Rebar - Group Bending List - Extended.rpt
• Rebar - Single Bar Bending List.rpt

Moving all rebar set related UDAs to one .inp file
Previously, rebar set related UDA definitions were in several separate .inp
files. Now they are in one file to make it easier to maintain the UDAs.

To do

The objects_rebar_set.inp file is now located in the common\system\
folder. If your environment does not follow common\system\, copy this file to
your environment's \inp folder and check if you get the rebar set UDAs.

Rebar shape manager
The following improvements have been made:

• There is a new tolerance setting Curve tolerance on the Tolerances tab.
This value is used to recognize the ‘arc’ in a bar that has multiple sequential
bendings.

• Rebar shape manager has been changed so that multiple sequential
bendings that form an arc are combined into one or more bendings (90
degree or less) with the arc radius.

Administrator's release notes: Updates in tools for concrete
fabrication

Export Unitechnik (79), and Export EliPlan file, and Export BVBS have been
improved.

For more information about the improvements, see Updates in tools for
concrete fabrication (page 61) in Tekla Structures 2019i release notes.

Administrator's release notes: Concrete components
There are several improvements in concrete components in Tekla Structures
2019i.
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Update your standard files if you want to take the new options and features
into use.

For more information about these improvements, see Improvements in
components (page 64) in Tekla Structures 2019i release notes.
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3 Localization release notes

Environment-specific Tekla Structures localization release notes introduce new
and changed features in the new Tekla Structures version from the localization
point of view. It lists the features that have been localized in your environment
and also helps you in your own customization tasks. The localization release
notes are supplied by the localization teams at your local area and reseller
offices.
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4 Upgrade Tekla Structures to a
new version

You can have many Tekla Structures versions on your computer. When you
install and start using a new version, you do not need to uninstall the older
versions and you can keep using them. Service packs are cumulative updates,
so they replace the previous service pack installation for the same Tekla
Structures version.

NOTE We recommend that you complete any models you are already working on
using your current version of Tekla Structures. Once you save a model in the
new version, you cannot open it in the previous versions anymore.

You can download the installation packages from the Tekla Downloads
service.

Complete the upgrade in this general order (follow the links in the text for
detailed instructions):

1. Update the Tekla license server (page 108). The updated version replaces
the existing version you have installed.

2. Renew your licenses as explained in Renew a Tekla license (page 109).

The renewed licenses can be used with the version indicated on the
license and any previous versions that are compatible with your installed
license server version.

3. Install Tekla Structures.

You can have many Tekla Structures versions and environments on your
computer. When you install and start using a new version, you do not
need to uninstall the older versions.

4. Copy personal settings to a new Tekla Structures version (page 110).

You can use the Migration Wizard (page 110) tool to copy some of the
personal settings to the new version. You can skip the copying if you do
not want to copy the settings, or if you want to copy the settings from
some other Tekla Structures version than suggested in Migration Wizard.
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5. Transfer customized information to a new Tekla Structures version
(page 111).

In the new Tekla Structures version, you can use the information you have
customized in the previous version. We strongly recommend that you
create project and firm folders, and store the files you customize in these
folders. Tekla Structures does not replace the files in project and firm
folders when you install a new version. If you do not use project and firm
folders, you need to transfer the customized information to the new
version manually.

4.1 Update the Tekla license server
We recommend that you have the newest version of Tekla license server
software installed on the Tekla license server. New versions of Tekla Structures
do not always work at all with older license server versions.

You can use older versions of Tekla Structures with a newer version of the
license server. In some older Tekla Structures versions, this requires that you
have installed recent enough updates; for more information about the
compatibility between Tekla Structures versions and Tekla license server
versions, see Which license server version to use.

To update the Tekla license server:

1. Save the model that you are working with and close Tekla Structures
before the server update.

2. Go to Tekla Licensing --> LMTOOLS through the Start menu or Start
screen, depending on your Windows operating system.

3. On the Stop/Start/Reread tab, click Stop Server to stop the Tekla license
server and any other licensing services. 

When you have completed installing the Tekla license server, you can
restart the other licensing services.

4. Backup any files you have modified in the C:\Tekla\License\Server
folder. 

You do not need to back up tekla.lic or tekla.opt, because the
installer will not changes these files.

5. Download the latest version of the Tekla license server and the optional
Tekla License Borrow Tool (if you use it) from Tekla Downloads.
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6. Install the downloaded license server with administrator rights using the
automatic installation for normal setup. Follow the instructions displayed
on the screen. 

If the installation fails or the server does not start after installation, try
reinstalling with the local firewall and antispyware/antivirus protection
disabled.

7. If you use the Tekla License Borrow Tool, install the new version of the tool
on workstations that need it.

4.2 Renew a Tekla license
License renewal means changing the details on an existing license, such as
updating the highest allowed software version or extending the validity period
of a temporary license. You deactivate the current license and then activate it
again with a new license entitlement certificate that contains the updated
information.

When you receive your renewed license, you must deactivate the existing
license and then activate the new version of the license. Two versions of the
same license cannot be active at the same time. License deactivation and
activation is done on License server (which can also be the same computer on
which Tekla Structures is installed) and requires an internet connection.

NOTE Before you deactivate licenses, ensure that the licenses are not in use
or borrowed. To deactivate the licenses, users must return any
borrowed licenses as explained in Return a borrowed Tekla Structures
license.

To renew a license:

1. Rename your previous entitlement certificate file in the license server
installation folder (by default C:\Tekla\License\Server) from
EntitlementCertificate.html to EntitlementCertificate-
OLD.html.

2. Save the entitlement certificate file to the license server installation folder.

The person in your organization who has made the license purchase, or
someone named as the contact person, receives a new
EntitlementCertificate.html entitlement certificate by e-mail as an
attachment.

3. Go to Tekla Licensing --> Tekla License Administration Tool through
the Start menu or Start screen, depending on your Windows operating
system.

Upgrade Tekla Structures to a new version 109 Renew a Tekla license



4. In the Activated Licenses area, select the Deactivate check box next to
the license you want to deactivate.

5. Click the enabled Deactivate button. 

When deactivation is complete, the License administration tool shows a
confirmation message.

NOTE Do not use automatic notification if you are using some other
FlexNet license and license server administration tool, such as
FlexNet Manager. To notify the license server about license
changes manually, see Activating Tekla Structures licensing using
manual server notification.

6. Make sure the automatic license server notification is enabled. Check the

status on the  Notify Server button in the toolbar and click the
button if necessary.

7. Click Open and open the EntitlementCertificate.html file that
contains the license. The license information is displayed in the Entitled
Licenses area.

8. Click the Activate cell and select the number of licenses to activate. 

9. Click the Activate button. 

Your license server contacts the license activation server at Trimble
Solutions.

The activated licenses are displayed in the Activated Licenses area.

We recommend that you back up the trusted storage (..\ProgramData
\FLEXnet\) in a safe place away from the computer running the license
server. Backups can help you restore your licenses on the same server if active
licenses are accidentally erased.
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4.3 Copy personal settings to a new Tekla Structures
version
You can copy some personal settings from an older Tekla Structures version to
a newer Tekla Structures version using the Migration Wizard tool. Migration
Wizard opens automatically when you start a new version of Tekla Structures
for the first time.

Migration Wizard shows the version number from which the settings are
copied and the version number to which the settings are copied. You can
select which settings are copied.

1. Start the new Tekla Structures version.

2. In Migration Wizard, click Next to start copying the settings.

3. Select the settings you want to copy and click Next.

4. Check that you have selected the correct settings.

5. Click Copy.

NOTE If you want to copy the settings later, you can start Migration Wizard manually
by double-clicking the MigrationWizard.exe in the \Tekla Structures
\<version>\nt\bin\applications\Tekla\Migrations folder. You can
select the version from which the settings are copied and the version to which
the settings are copied.

See also

Upgrade Tekla Structures to a new version (page 107)

4.4 Transfer customized information to a new Tekla
Structures version
You can transfer customized information from a previous Tekla Structures
version to the new Tekla Structures version.

1. If you have used project and firm folders to store customized files in a
model using a previous Tekla Structures version, go to File menu -->
Settings --> Advanced Options and check that the XS_FIRM, 
XS_PROJECT and XS_COMPANY_SETTINGS_DIRECTORY advanced options
point to the folders where the customized files are located.

2. If you have not used project and firm folders to store customized files, you
need to transfer the customized files manually to the new Tekla Structures
version to use the information. 
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Many types of files can be copied using a local or private online Tekla
Warehouse collection. See Tekla Warehouse instructions for more
information.

Check at least the following:

• Advanced options

• Files related to templates, reports and drawings

• Catalog files: profile catalog, material catalog, bolt catalog, bolt
assembly catalog, rebar shape catalog

• Conversion files

• Extensions

You need to re-install extensions for the new Tekla Structures version.

• NC export settings

• Printer catalog settings

• User-defined attributes

• Saved model object properties

You can copy some information automatically to the new version using
the Migration Wizard (page 110) tool.

See also

Upgrade Tekla Structures to a new version (page 107)
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5 Tekla Structures service packs

Tekla Structures service packs are Tekla Structures version updates.

Service pack software installation files are stand-alone installers that contain
the full Tekla Structures version software. You do not need to separately install
the related Tekla Structures version or a previous service pack. For example,
you can install service pack 2 without installing service pack 1.

• Service packs can include new features, and improvements and fixes to
existing features. We recommend that all users install the latest service
pack.

• We recommend that you install the latest environments to ensure that the
environments work correctly in the service pack. We recommend that you
update all the environments that you are using.

You can find the service pack software and environment installation files in
Tekla Downloads.

See also

Install a Tekla Structures service pack (page 113)

Install an earlier Tekla Structures service pack (page 115)

5.1 Install a Tekla Structures service pack
You can install a service pack to update a Tekla Structures version or a
previous service pack. Service packs can contain new features, and
improvements and fixes to existing features.

NOTE Service pack software installation files are stand-alone installers that
contain the full Tekla Structures version software. You do not need to
separately install the related Tekla Structures version or a previous
service pack.
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If you have the related Tekla Structures version or a previous service pack
installed on your computer, you do not need to remove it before installing a
new service pack.

NOTE You need to be logged in with administrator rights to install the Tekla
Structures software on your computer.

1. Install the Tekla Structures service pack software.

a. Download the service pack software installation file from Tekla
Downloads to your computer.

b. Double-click the installation file to run the installation.

c. Follow the steps in the installation wizard to complete the installation.

Note that if you have the related Tekla Structures version or a
previous service pack already installed, you cannot select the
installation folder. The service pack will be installed to the same
folder as the version that you are updating.

If you do not have the related Tekla Structures version or a previous
service pack installed, you can select the installation folder and the
model folder.

2. Install the Tekla Structures environments. 

Note that the location of the environment installation folder depends on
where you have installed the software. You cannot select the environment
installation folder in the installation wizard.

You do not need to remove any environments. Installing a newer version
of an environment automatically upgrades the older version of that
environment.

a. Download the needed environment installation files from Tekla
Downloads to your computer.

b. Double-click the installation file to run the installation.

c. Follow the steps in the installation wizard to complete the installation.

You can select in the installation wizard that the environment setting
files (.tsep) are installed when running the environment installation
wizard.

If you do not select to do this, the environment setting files are
installed to the environment folder when you start Tekla Structures
after the installation. Tekla Structures opens a dialog box that shows
the installation progress.

Related information
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See also

Tekla Structures service packs (page 113)

5.2 Install an earlier Tekla Structures service pack
We recommend that you use the latest Tekla Structures service pack. In certain
situations, you may need to take an earlier Tekla Structures service pack, or
the related Tekla Structures version, into use even though you are already
using a newer service pack.

1. Uninstall the Tekla Structures service pack software you are now using in
Windows Control Panel.

2. Uninstall the related Tekla Structures environments in Windows Control
Panel.

3. Install the Tekla Structures service pack software.

a. Download the software installation file of the service pack from Tekla
Downloads.

b. Double-click the installation file to run the installation.

c. Follow the steps in the installation wizard to complete the installation.

You can select the installation folder and the model folder.

4. Install the Tekla Structures environments. 

The latest environments are in Tekla Downloads.

a. Download the environment installation files related to the service
pack that you have installed.

b. Double-click the installation file to run the installation.

c. Follow the steps in the installation wizard to complete the installation.

You can select in the installation wizard that the environment setting
files (.tsep) are installed when running the environment installation
wizard.

If you do not select to do this, the environment setting files are
installed to the environment folder when you start Tekla Structures
after the installation. Tekla Structures opens a dialog box that shows
the installation progress.

See also

Tekla Structures service packs (page 113)
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6 Disclaimer

© 2019 Trimble Solutions Corporation and its licensors. All rights reserved.

This Software Manual has been developed for use with the referenced
Software. Use of the Software, and use of this Software Manual are governed
by a License Agreement. Among other provisions, the License Agreement sets
certain warranties for the Software and this Manual, disclaims other
warranties, limits recoverable damages, defines permitted uses of the
Software, and determines whether you are an authorized user of the Software.
All information set forth in this manual is provided with the warranty set forth
in the License Agreement. Please refer to the License Agreement for important
obligations and applicable limitations and restrictions on your rights. Trimble
does not guarantee that the text is free of technical inaccuracies or
typographical errors. Trimble reserves the right to make changes and
additions to this manual due to changes in the software or otherwise.

In addition, this Software Manual is protected by copyright law and by
international treaties. Unauthorized reproduction, display, modification, or
distribution of this Manual, or any portion of it, may result in severe civil and
criminal penalties, and will be prosecuted to the full extent permitted by law.

Tekla, Tekla Structures, Tekla BIMsight, BIMsight, Tekla Civil, Tedds, Solve,
Fastrak and Orion are either registered trademarks or trademarks of Trimble
Solutions Corporation in the European Union, the United States, and/or other
countries. More about Trimble Solutions trademarks: http://www.tekla.com/
tekla-trademarks. Trimble is a registered trademark or trademark of Trimble
Inc. in the European Union, in the United States and/or other countries. More
about Trimble trademarks: http://www.trimble.com/trademarks.aspx. Other
product and company names mentioned in this Manual are or may be
trademarks of their respective owners. By referring to a third-party product or
brand, Trimble does not intend to suggest an affiliation with or endorsement
by such third party and disclaims any such affiliation or endorsement, except
where otherwise expressly stated.

Portions of this software:

D-Cubed 2D DCM © 2010 Siemens Industry Software Limited. All rights
reserved.
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EPM toolkit © 1995-2006 Jotne EPM Technology a.s., Oslo, Norway. All rights
reserved.

Open Cascade Express Mesh © 2015 OPEN CASCADE S.A.S. All rights reserved.

PolyBoolean C++ Library © 2001-2012 Complex A5 Co. Ltd. All rights reserved.

FLY SDK - CAD SDK © 2012 VisualIntegrity™. All rights reserved.

Teigha © 2002-2016 Open Design Alliance. All rights reserved.

CADhatch.com © 2017. All rights reserved.

FlexNet Publisher © 2014 Flexera Software LLC. All rights reserved.

This product contains proprietary and confidential technology, information
and creative works owned by Flexera Software LLC and its licensors, if any. Any
use, copying, publication, distribution, display, modification, or transmission of
such technology in whole or in part in any form or by any means without the
prior express written permission of Flexera Software LLC is strictly prohibited.
Except where expressly provided by Flexera Software LLC in writing,
possession of this technology shall not be construed to confer any license or
rights under any Flexera Software LLC intellectual property rights, whether by
estoppel, implication, or otherwise.

To see the third party open source software licenses, go to Tekla Structures,
click File menu --> Help --> About Tekla Structures and then click the 3rd
party licenses option.

The elements of the software described in this Manual are protected by
several patents and possibly pending patent applications in the United States
and/or other countries. For more information go to page http://
www.tekla.com/tekla-patents.
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